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ChessPartner 5.1
Welcome to the ChessPartner on-line help. The help is built such that it follows the menu structure of the 
program, you can walk the various trails from the following top-level menus; Alternatively, you may press 
F1 at any time a menu or dialog is active. Context help will then be presented.
If you want more information on how to use the program press the Contents button.
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Layout
Windows
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Copyright
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File menu

Below this menu several choices are available for loading and saving games in the Chess-database(s). 
Besides the opening book manipulation selections, also the printing sections of ChessPartner can be 
found here.

Games Filter
Save Game As
Save Game
Print
Print Settings
Open Database
New Database
Export
Database Maintenance
Book Maintenance
Exit



Edit menu

Below this menu several choices are available that let you manipulate the move list and the 
chessboard. You may select from: 

Rotate Board
Edit Position
Copy
Copy Game
Copy Game As Font
Paste



View menu

The following functions are available:
 
Toolbars
Select Clock…
Select Piece Set…
Properties



Game menu

To take control over your game the items from this menu enable you to do any of the 
following:

New Game
Start Game
Stop Game
Flag
Offer Draw
Resign
Adjourn
Abort
Game Details
Players
Analysis mode
Level
Clocks



Moves menu

To assist you in managing the list of moves, this menu provides choices that affect the list and the moves 
to come...
For further assistance click on:

Valid Moves
Next Best
Hint
Computer Move
Immediate
Annotate…
Annotation Symbols
Navigation
Delete move(s)



Internet menu

Below this menu function are available to play a game over the Internet.
 
Load Profile…
New Profile
Save Profile
Save As…
Connect
Disconnect
Seek 
Cancel Seek 
Challenge
Observe
Stop Observing
Who
Games
Rematch
Clear Window



Extra menu

Various settings that control the behavior of ChessPartner can be edited here. They are 
categorized as:

Save Settings
Analyze Game(s)
Analyze EPD
Analyze Postion
Select Engine…
Engine Properties…
Create Desktop Shortcut
Options
Customize
Macros
Autoplayer232 



Layout menu

This menu lets you quickly change the layout of the ChessPartner windows. You can use any 
of the pre-defined layouts or create and save your own layouts.



Windows menu

These choices let you manipulate the various windows of ChessPartner:

Initial Position
Optimum Size
Arrange Icons
Refresh



Help menu

Here you’ll find the About dialog, which tells you some details of ChessPartner. Of course, 
the various entrances to the help system are here too:

Contents
Index
Help On Help
Keyboard Help
Tip of the day
Help on the web
Register
About



Games Filter

When the database contains many games it would be nice to only search part of the database. With the 
Games Filter function the database can be filtered on several ‘keys’. E.g. search for games played by 
Jan Timman, or played by Fisher with black etc. 

Note:
Databases that operate without an index file (PGN) can be considerably slower in displaying the result.



Saving a game or position.

It's simple; you can either replace or save a game after editing the Game details. Do so by selecting Save 
Game... from the Files menu. Replacement requires that the game have been recalled from the database 
previously. Save Game As... adds the game to the database. Whenever you choose New game the 
replacement function will be disabled to prevent you from overwriting an existing game with a game that 
has no moves played yet!

Use Save Game as ... to add the game in a new record to the database. Using this function repeatedly 
for the same game wastes disk space since you create multiple copies of the same game. The 
ChessPartner database does not provide for unique game-records.

The save functions allow you to use a compressed format, consuming as little disk space as possible. 
The time used each move is then not saved in the database, this is only kept using the normal format 
which also uses a larger format to store the move list.



Printing

At any moment you may print a full report of the game played so far. The move list is put to 
paper and also the chessboard can be printed that can reflect a position somewhere in the 
game (not necessarily the last move).

By selecting a move from the move list (see Taking back moves) the chessboard shows the 
position at that moment in the game. When you next print the report, that chessboard is 
printed together with a comment telling which move was played for that situation.

Several print options can be set with the Options function from the Extra menu.



Print Settings

A common part of almost every windows application is its ability to change the settings of the 
printer. ChessPartner therefore offers the same. But since a dialog is used that is part of the 
printer-driver, it may not necessarily be in the English language!

Choose Print Settings… from the File menu to adjust the printer to your wishes. 



Opening a chess database

To open a database with ChessPartner games a dialog is presented. The dialog is similar to the 
"standard" file-open dialog found in today's applications.
In a box within the dialog the names of database files are shown. For an easier identification than just the 
filename, a descriptive text is displayed when a file is selected. This text is determined upon creation of 
the database. When the selected file is not a ChessPartner database there is, of course, no text.
As a default, the ChessPartner Database type of files are listed but other formats such as PGN are also 
supported and can be chosen from the file type(s) box.

There’s a change the message “Database is read only” is presented. This means the database is already 
in use by another program for read/write or you checked the read-only box.

It is possible to have multiple databases open, each database is displayed in its own window. Games can 
be moved or copied between two databases by simply dragging the selected games to the target 
database.



Creating a new chess database

To fulfill any wishes for multiple databases it is necessary for you to create new and empty databases 
from ChessPartner. The function to do so can be found under the Files menu. A descriptive text on the 
contents of the database can be attached.

The dialog allows you to enter a filename with either a path and/or drive letter and optionally an 
extension. Any extension you typed will be matched with the appropriate file type. When not matched, the 
currently selected file type will be used to store the database.



Closing the active database

When the current database is no longer required for direct access, it can be closed with the appropriate 
menu-selection or by just closing the database window.



Database Export

ChessPartner offers a feature to move multiple games to another database in one go. To do so, choose 
Export… from the File menu. The first field allows you to define the destination database file, type and 
location. The source database is always the current active database. Using the Browse button you can 
easily locate an existing database file to append the games to.
There’s a radio button that lets you choose between exporting the entire amount of games and a 
selection of games using the Filter dialog.

The destination database can be any of the supported formats although not all formats that ChessPartner 
can read may be available here (write).
By marking the check box Remove from source database, successfully transferred games will be 
removed from its source database. The availability of this feature may depend on the type of database 
you are exporting from.

Pressing the Start buttons starts the export function.



Information about a database

Every database has room for some descriptive text that provides a general description of its contents. To 
review this text, the amount of games and positions present and also the number of deleted games an 
information dialog is available. The dialog can be activated through the database maintenance menu or 
the "open database" dialog. Games marked for deletion still take up disk space that can be recovered by 
using the Compress function from the database maintenance menu.



Re-indexing the database

Sometimes it may be necessary to re-generate the index file (.LDX extension). When the compression or 
a save procedure is interrupted or when a system-crash has occurred. Also when ChessPartner produces 
database errors it's advised to regenerate the index file and try again.

It is possible to interrupt the re-index process but not recommended. The index file is only replaced when 
the re-indexing is completed, therefore Interruption results as if the re-index has not been issued at all!



Compressing the database

When a database has a lot of games and/or positions that are marked as deleted, it's recommended to 
run a compression phase to decrease the size of the database. This results in less disk space taken by 
the files. If you have a game on the board that needs saving, do so BEFORE compressing the database. 
Afterwards you will not be able to REPLACE the game, saving it as another game is possible of course.

Do not confuse this compression function with the compressed format in which games can be saved 
within the database. That format simply takes less space for the list of moves and time tracking is also not 
present. It is recommended to use the compressed format where possible to save ever so scarce disk 
space. See also Normal format, and Extended format.



The opening book

ChessPartner allows you to maintain your own set(s) of openings next to, or in place of the main book 
supplied with ChessPartner. Multiple user books may exist and can be active at the same time. Switching 
between user books can done at any time during the game.
Various functions related to the user book can be found below the Book maintenance sub menu located 
under the File menu. It is also possible to let the selected Chess engine handle it’s own book, in that 
case some of the functions described below are not active.
Some additional options are available from the book moves window by selecting the books tab.

You can manipulate the user book from the following menu selections from the Book Maintenance below 
the Files menu:

Open Book
New Book
Add Variation
Delete Variation
Book Properties



Selecting a user book

During or before starting a game you may select a certain user book with openings. This enables you to 
prepare some specific opening strategies for a known opponent. It is also possible to disable the main 
book and have the user book do all the work. In such a case be sure to have plenty of opening data in 
your book or the results will not be satisfying.

Selecting the file that holds the book is as easy as in any other windows application through the use of a 
standard dialog. A user book has the .BK extension and by selecting it in the list box, its describing 
comment is displayed at the bottom of the dialog without actually loading the book. Use the OK button to 
confirm your selection.



Creating a user book

By choosing New Book a dialogue allows you to enter a filename. A second dialogue allows you to enter 
a description of the book and the type of book. The filename must have the .BK extension and will be 
automatically selected as the active user book.



Adding variations

In order to add variations to the user book, the menu choice Add Variation may be selected. The dialog 
displayed presents the current variant played on the board. This variant can be added to one of the open 
user books. When adding, a score must be defined seen from the White player’s point of view. The score 
can be a positive or negative value.



Deleting variations

The variation can also be removed from the book. It is safe to remove the entire variation even when it 
overlaps another variation present in the book. The overlapping part is kept.



Book Properties

Calls up the book properties page.



Ending ChessPartner

ChessPartner can be exited in several ways. The preferred way is by selecting the Exit choice from the 
Files menu. This will enable you to save the current settings of ChessPartner by presenting a little dialog.

Alternatively you use the Alt+F4 or Ctrl+X key-combinations or double-click the system menu of 
ChessPartner's main window. This will end ChessPartner immediately without saving the current settings. 
The database in use and some other parameters that are expected to be in the same state as when 
ChessPartner was last used are still saved though!



Rotating the chessboard 180°

When the player has white and ChessPartner plays black, the players expected view is that white plays 
from bottom to top. In case the player wishes to play black however, this view is not handy and therefore 
it is desirable to turn the chessboard.

Choosing Rotate from the Edit menu will turn the chessboard. The menu selection will be marked to 
indicate that black’s view is set. Choosing the menu item again will restore white's point of view.

When you are to setup a position on the board and the rotated view was active, the board is rotated back 
before starting setup. This to ensure the same point of view for each setup. When returning to the game 
mode, the previous state of rotation is restored.



De niet-geroteerde toestand is die waarin Wit van onder naar boven speelt. Het veld a1 bevindt zich dan 
in de linkerbenedenhoek van het schaakbord window.



Het vlag symbool()verschijnt voor een menuselectie ten teken dat de functie AAN staat.



Setting up a position

When you wish to start a game from a certain position or evaluate one, it is necessary to set and remove 
various chess pieces on the board. The Edit Position choice from the Edit menu will help you in putting 
pawns and others in place.

Obviously a position can also be stored and re-called    from a database 

When you start the setup position, a toolbar appears which contain the chess pieces, an empty field and 
a checkmark. To clear a field click on the empty field button then on the field(s) you want to clear.
Pieces already on the board can be dragged to the desired position. To add a new piece first select the 
piece on the toolbar, then just drop it on the board.
All functions are also available as context menu by clicking the right mouse button.

If the setup is to your liking press the checkmark on the toolbar which brings you to the Castle rights  
dialog



Setup: Castle rights

The castle rights are active (allowed) when the check boxes are marked. You can mark a box by clicking 
on them. To be able to turn a castle right to on, the required pieces need to be in their appropriate position 
(Rook and King). A thread for check may not be present also. If these rules can not be applied, the castle 
right can not be set!

The player’s color that may play the next move is selected by one of the radio buttons. When you choose 
black, the move list will show a 1. ... notation for the first move of white. Note that any previous move list 
is cleared when a setup is accepted.

It is recommended to save a setup immediately after acceptation for future use. This will keep you from 
entering the same position again.



Copy function
· Most windows can be copied to the clipboard by selecting or activating the window, then the Copy 

function from the Edit menu.
The windows are copied on the clipboard as a color bitmap.

· It is also possible to copy the chessboard as figurine font onto the clipboard. Use the Copy Board As 
Font function from the Edit menu. The function uses the Traveler True Type font, the target 
application should of course support this font. (e.g. Word or Write)

· The Copy Game function copies the complete game on to the clipboard. The game is copied in 
various formats including a plain text format. All game details including annotations are copied.

· If the Copy function is selected while the moves list is active, then the text formatting is also copied.



Pasting moves or positions from clipboard

ChessPartner allows you to take move notation lists from the clipboard. These are handled in sequence 
and tested for validity. A couple of rules must be obeyed:

The moves on the clipboard must be in a text format, not graphical. When a non-text format is present the 
paste function is disabled.

The moves on the clipboard are appended to any existing moves in the current list! So, when you have a 
list that's from the very beginning of a chess game, you must first select new game before pasting the list

The notation format is flexible but requires attention. Any leading move numbers are accepted but not 
used. Punctuation and spacing characters are also ignored. Both long and short notation are then 
understood, chess specifics like '+' and '++' are not interpreted.

During the paste function each move is verified and only put on the board when found valid. When an 
invalid move or move notation is detected an error message is popped up and the process halts.

Note that sometimes a move notation may have two meanings, the so called ambiguous move. This will 
open up a window with the available valid moves that apply for the notation. Usually a chess player picks 
out the correct move. In case you picked the wrong move the chess brain may stop the pasting some 
moves further down the list . . . ! try choosing one of the other moves when you repeat the paste. Do not 
forget to reset the current move list first.

*By using the long notation format on the clipboard, any ambiguity problem is avoided.

It is also possible to paste a position from the clipboard, the position must be in FEN notation format.

FEN is "Forsyth-Edwards Notation"; it is a standard for describing chess positions using the ASCII 
character set.

A single FEN record uses one text line of variable length composed of six data fields.

FEN specifies the piece placement, the active color, the castling availability, the en passant target square, 
the halfmove clock, and the fullmove number. These can all fit on a single text line in an easily read 
format.    The length of a FEN position description varies somewhat according to the position.

The first field represents the placement of the pieces on the board.    The board contents are specified 
starting with the eighth rank and ending with the first rank. For each rank, the squares are specified from 
file a to file h.    White pieces are identified by uppercase SAN piece letters ("PNBRQK") and black pieces 
are identified by lowercase SAN piece letters ("pnbrqk").    Empty squares are represented by the digits 
one through eight; the digit used represents the count of contiguous empty squares along a rank.    A 
solidus character "/" is used to separate data of adjacent ranks.

The second field represents the active color.    A lower case "w" is used if White is to move; a lower case 
"b" is used if Black is the active player.

The third field represents castling availability.    This indicates potential future castling that may or may not 
be possible at the moment due to blocking pieces or enemy attacks.    If there is no castling availability for 
either side, the single character symbol "-" is used.    Otherwise, a combination of from one to four 
characters are present.    If White has kingside castling availability, the uppercase letter "K" appears.    If 
White has queenside castling availability, the uppercase letter "Q" appears.    If Black has kingside 
castling availability, the lowercase letter "k" appears.    If Black has queenside castling availability, then 
the lowercase letter "q" appears.    Those letters which appear will be ordered first uppercase before 
lowercase and second kingside before queenside.    There is no white space between the letters.



The fourth field is the en passant target square.    If there is no en passant target square then the single 
character symbol "-" appears.    If there is an en passant target square then is represented by a lowercase 
file character immediately followed by a rank digit.    Obviously, the rank digit will be "3" following a white 
pawn double advance (Black is the active color) or else be the digit "6" after a black pawn double 
advance (White being the active color).

An en passant target square is given if and only if the last move was a pawn advance of two squares.    
Therefore, an en passant target square field may have a square name even if there is no pawn of the 
opposing side that may immediately execute the en passant capture.

The fifth field is a nonnegative integer representing the halfmove clock. This number is the count of 
halfmoves (or ply) since the last pawn advance or capturing move.    This value is used for the fifty move 
draw rule.

The sixth and last field is a positive integer that gives the fullmove number. This will have the value "1" for 
the first move of a game for both White and Black.    It is incremented by one immediately after each 
move by Black.
 

Here's the FEN for the starting position:

rnbqkbnr/pppppppp/8/8/8/8/PPPPPPPP/RNBQKBNR w KQkq - 0 1

And after the move 1. e4:

rnbqkbnr/pppppppp/8/8/4P3/8/PPPP1PPP/RNBQKBNR b KQkq e3 0 1

And then after 1. ... c5:

rnbqkbnr/pp1ppppp/8/2p5/4P3/8/PPPP1PPP/RNBQKBNR w KQkq c6 0 2

New in this version is the ability to directly paste PGN games. In that case the complete game is loaded 
including the various tags, comments and variations.



Toolbars

There are several toolbars available, by moving the mouse over a toolbar button a small text window 
appears describing the function of the button.
Toolbars can be dragged from the frame window and used as popup window, or can be docked on the 
main frame window.
Toolbars can be selected from the View menu.



Kleuren instellen

xxMet deze menu keuze kunt u divers kleur gebruik door Schaakmeester wijzigen.



Selecting a clock

The Chess clock can be presented as a graphical image of the mechanical Chess clock. The type of 
graphic you'll see can be selected just as the various Piece sets. When selecting a different clock, it will 
be shown in its optimum dimensions in which it was originally drawn. You may change the size of the 
clock using the normal windows controls, but this may produce a disturbed image.



Selecting Chess Pieces

The appearance of the Chess Board can easily be changed by selecting a different set of Chess Pieces. 
A few different sets are distributed with ChessPartner. 

The available Piece sets are listed in the INI file. That name appears above the graphic in the dialogue's 
list box. Only a few Pieces are shown in the list, not the entire set. Changing the current set may also 
change the field colors of the Chess Board.



Properties

Show the properties of the selected item



Beginning a new game

Selecting New Game from the Game menu will put the initial chess setup on the board. The chess brain 
is stopped if necessary. The clocks are reset for the current level of play and the opening book is to reflect 
the first move.

If there still was a not-saved game on the board ChessPartner asks you whether or not you wish to keep 
that game before erasing it forever. This confirmation protects you from accidental loss.



Starting or continuing a game

To (re-)start the chess clock the chess brain needs a little push. This push can be given with the Start 
Game selection form the Game menu. The clock is automatically started when you issue a move on the 
board. The key-combination Ctrl+S can also be used to (re-)start the game.

A move can be issued selecting from the opening book or the list of valid choices or by letting 
ChessPartner do the move. Each of these actions will set the chess brain to work and its evaluation 
functions.

In case you wish to stop the game you bring the chess clock to stop



Interrupting a game

Any game can be interrupted (temporary) to adjust the level of play or simply to take a break. Sometimes 
ChessPartner stops the game because of certain player actions.

Stopping the game and the clocks can be achieved by selecting the appropriate menu item from the 
Games menu or pressing Ctrl+P (pause) keys.

In a number of cases the clocks are stopped automatically:

changing player definitions
saving the game
recalling a game from the database
setting a new level of play
starting new game
moving back- or forwards in the move list



Flag

When the opponent player is out of time use the Flag function to claim a win.



Offer Draw

Use the Offer Draw function from the Game menu to send a draw offer to the opponent or to 
the chess engine. The opponent can either accept or reject the draw offer.



Resign

At any given time the current game can be resigned. Use this function to send the resign 
signal to the chess engine or the opponent player.



Adjourn

The Adjourn function under the Games menu is used to temporarily stop a game to be 
continued later. The Adjourn command is sent to the chess server that forwards it to the 
remote player.



Abort

This function sends the Abort command to the chess server.
See also Adjourn



Changing game details

This function allows you to edit the player names, game comment, start and stop dates and times and a 
user definable key can be entered or changed. These details are used for saving the game later in the 
database. Upon saving the same details dialog is presented to allow last or first minute changes.



Defining the players

Who will be playing with white and black can be set through the Players selection from the Game menu, 
or using the Ctrl+D keys.

In the dialog presented you can choose the player for each color. Possible selections are Player, 
Computer, and Remote. Normally the Remote selection is done automatically when a Internet connection 
is established.
The Swap button swapped the roles of the white and black player.

By pressing the OK button or the Enter key your selection is activated. Use Cancel to leave things the 
way they are.



Analysis mode
Selecting Analysis mode from the Game menu automatically places the player’s mode in player/player 
and sets the engine in analysis mode. The effect is that every position on the board is automatically 
analyzed. You can freely navigate through your game, play new moves, load games etc. The statistics 
window will always shows you what the engine things about the position.



Setting the level of play

A game can be played at different degrees of difficulty. ChessPartner has levels for tournament type of 
games and fixed methods. The levels can be set with a dialog available through Ctrl+N or selecting Level 
... from the Game menu.



Adjusting the clock

On some occasions you may wish to adjust the setting of the clock for any of the players. During 
computer Chess tournaments for instance you must compensate for the time the operator needed to 
input moves. The time set on the real clock can be copied to the ChessPartner clock.

Selecting Clocks… from the Game menu brings up the clocks dialog.

The dialog enabling you to do so shows the current time on right, and has editable fields on the left for 
black and white. The new values must be entered as hh:mm:ss where the hours and minutes are optional 
but the seconds are always mandatory.

NOTE: Only the changed values are passed to the Chess Brain. In case you make a change to the time 
for black but leave the field for white alone, only black's clock is adjusted! So, when you leave the dialog 
in view for ± 5 minutes and press Enter without making changes, the clock setting will NOT be changed 
and the meanwhile 5 minute old values are NOT passed on.



Valid moves

If you need to know if the move you've got in mind is valid, you can pop-up a window that shows all valid 
moves for the given position. Choose this item from the Moves menu.

Next you can use the mouse or the keyboard to select a move from the list that than will be executed on 
the board. You do not need to type it in again or move the desired piece. Enter or a double-click issues 
the move. Escape closes the window.



Playing the next best move

When ChessPartner plays a move from the opening book or end-game database it’s likely that there are 
more possible moves to play. That list of moves is sorted having the best on top. By selecting Next best 
from the menu or press Ctrl+Z the already played move is taken back and the next move in the list is 
placed on the board. That and consecutive next best moves have a lower score that the initial move. The 
list is circular, you may rotate through the next best moves till the first shows up again.

Next best is only available if there’s more than one move.



Hint

Use this function to get a hint, there is not always a hint available.



Let ChessPartner generate the players move

When it's the players turn and he/she wants to have the move calculated by ChessPartner, the Computer 
move menu item is to be selected from the Moves menu. Alternatively the Ctrl+C keys could be pressed.

Next the chess brain generates a move on the board just as if it where his turn.



Forcing ChessPartner to play a move

When ChessPartner is calculating a move, you may tell the brain to stop thinking and play the best move 
found so far. Choose Immediate from the Moves menu to stop the current evaluation of variants and play 
that move. Ctrl+O keys act as a shortcut.

What the best move so far is can be viewed through the statistic's window. When ChessPartner is not 
thinking there's nothing to interrupt and an error message will result.



Adding comments to moves

Each move played can have an annotation added to it, use the Annotate function from the move menu to 
view or edit the annotation.
The annotation can be shown in the move-list and optionally printed.
It is possible to have ChessPartner generate annotations by using the Analyze game function.



Navigation

There are several ways to navigate through the game:

Taking back moves

Sometimes you may desire to go back a couple of moves. Not to cheat but to see what ChessPartner 
does on your alternate moves. To take back moves several ways are available.

From the Moves menu the choice Back can be selected, or you may use Ctrl+T or Ctrl+left-arrow key 
combinations. Pressing the right mouse button when the pointer is over the Chess Board has the same 
effect. All these will take back a single move even when it was played by ChessPartner.

To move back a number of moves in one go, you may use the mouse to double click the move in the list. 
That move will then be the last one played on the board. The remaining moves are still in the list, 
available for moving forwards. The move list can also be altered through the keyboard using the standard 
MS-Windows key assignments.

The buttons in the toolbar can be used to navigate through the list.

The chess clock is stopped each time you change the last played move!

When you play a new move while not at the end of the list, a new variation is inserted.

Walking the move list forward

Choose Forward from the Moves menu or use Ctrl+V or Ctrl+right arrow keys to walk the move list 
towards the end. The fashion in which this operates is similar to the taking back moves procedure. We 
suggest reading that topic too.

Lines

ChessPartner has the option to play multiple lines in a single game. To create a line move back in the 
moves list from where you want start a alternative continuation, then just start playing the new moves. In 
the moves list this new variation is displayed in-between brackets and in a different color.
To leave the variation either click somewhere outside the line or press the MainVariant button.

Deleting moves or variations
Use the Delete move(s) function from the Moves menu or click the X symbol on the navigation toolbar to 
delete one or more moves or variations.
All moves following the current move are deleted. If you are inside a variation, moves are deleted until the 
end of the variation. If there are no moves left in the variation, the whole variation is deleted.



Load Profile

Open a Internet Console with the Load Profile function from the Internet menu. The Internet console 
contains a definition for connecting to a chess server. A number of chess servers have been pre-
configured.

When the console opens a window is displayed with a toolbar that contains function to connect, 
disconnect, change properties. Etc.

To connect to the chess server press the connect button or the Connect function from the Internet menu. 
When the connection is established ChessPartner will automatically log you on.

You can create you own definitions by selecting the New Internet Console menu option



New Profile

This function works the same as the Load Profile, except the server parameters need to be defined.



Save Profile

Use this function to save the Internet Console in a file. Use Save As to save the console under a different 
name.



Connect

To connect to a chess server, first make sure you have a active connection to the Internet, then click the 
connect button or select the Connect function from the Internet menu. This brings up the Connect 
dialog, make any desired changes to the connect parameters, fill in a user name and an optional 
password then press OK to initiate the connect sequence. 

If the connection is successful the Chess Server welcome screen is displayed. If the username you have 
chosen is in use then the Chess Server breaks the connection. Try a different name until it is accepted.



Disconnect

Disconnects you from the Chess Server.



Seek
Use this function to place an ‘advertisement’ to play a match. A dialog allows you to set various 
parameters, e.g. Rated/unrated, a rating range, colors, etc.



Cancel seek
Use this function to cancel all of your current ads for chess matches.



Challenge

To challenge a remote player for a match proceed as follows:
Check who is online using the Who function from the Internet menu
Move the mouse cursor over the player you want to challenge and press the right mouse button.
From the popup menu select: Challenge -> player 
This sends a match request to player 
When player accepts the match request you are ready to play.

When someone challenges you, use the accept or decline command to accept or decline the match 
request. If there is more then one challenge the challenges are labeled with a name and number. Use this 
name or number in the accept or decline command.



Observe

With the Observe command you can watch others play. Use the Games function to request a list of 
games, then right click the mouse on the game you want to observe. From the context menu select 
Observe From there on you will see all moves the players are making.

Use the Unobserve function to stop watching the game.

If you don’t want others to observe your games use the “set private 1” command. To cancel use “set 
private 0”



Unobserve

Stops observing a game



Who

The Who menu function is used to request of available players. The request can be done with several 
criteria e.g. Players open for matches, Rated players etc.



Games

The Games menu choice requests a list of active games from the Chess Server.



Rematch

Sends a rematch command to the chess server to start a match with your last opponent using the same 
parameters as the match before.



Clear Window

Clears the contents of the console window.



Save Settings

Each time you run ChessPartner, the various windows appear at predetermined positions. A certain level 
of play is set, player names and many other variables that ChessPartner uses. These values can be 
changed during a ChessPartner session and be kept for next sessions to save you from resetting your 
preferences. Saving defaults is selected through the Options menu, or by checking the box in the exit 
dialog.



Analyse game

ChessPartner can analyze a game loaded from the database. The calculated moves will be attached as a 
comment to the move in the list. In this way you may review what ChessPartner’s opinion about the 
game would have been. There are several parameters you may set to change the behavior of the 
analysis;



Analyze EPD 
Analyzes positions from a EPD file, it also processes the EPD commands that are found in the file. The 
result is stored in a simple text file. A summary containing number of positions analyzed, time needed to 
analyze and number of solved positions is shown.



Analyse a position

This function starts analyzing the current position the current level is used. Optional certain moves can 
either be included or excluded from the analysis.



Select Engine

After selecting this function, a dialog is presented with a list of installed engines.



Engine Properties

Adjust the engines specific parameters. What is displayed depends on the currently active engine.



Create Desktop Shortcut

This function creates a shortcut on the desktop which starts ChessPartner with the engine you currently 
have selected. This is independent of the of any engine you select later, thus starting ChessPartner 
through this shortcut always loads the engine you have choosen.



Options

With this function from the Extra menu the option property pages are shown. 



Customize
It is possible to customize the toolbars and the menus. The customize functions can be accessed from 
the Customize function under the Extra menu.
The property page contains several tabs to customize the menus and tool bars. Most of the functions are 
accessible using drag and drop. Once in customize mode, buttons and menus can simply be dragged and 
dropped to your liking. 
Once the setup is to your liking it can be saved as part of a layout.



Macros

No documentation available yet. Check the following web site for more information:
http://www.lokasoft.nl
or
http://www.lokasoft.com



Autoplayer232

The auto232 player software allows you to play automated matches against other chess programs that 
support the auto232 interface. Also some chessboards use this interface.

The auto232 interface is originally defined by Ch.Donninger

In order to use the interface you need a special RS232 cable, a so-called nul-modem cable.

One program must be started as 'master' the other as slave. The ChessPartner program can be both 
used as 'master' and as 'slave'

Played games can be saved automatically, make sure to have a database open before starting the 
autoplayer. Also fill in some game details.

THERE IS NO SUPPORT ON THE AUTO232 INTERFACE, IF IT DOES NOT WORK, YOU MAY 
REPORT IT, BUT WE MAKE NO WARRANTIES WHETHER WE FIX IT OR NOT.WE ALSO KEEP THE 
RIGHT TO REMOVE THIS FUNCTION FROM FUTURE VERSIONS.



Showing windows at the default position

All the windows that ChessPartner uses can be moved and their sizes changed. When you 
did a lot of changing and are not happy with it, you can restore the previous saved setting 
from the Windows menu. Selecting the Initial position menu item will put the windows back 
in place.

Whenever you check the save defaults option, the next time you start ChessPartner the 
windows will be in the position you than saved.



Showing window at optimum size

This function attempt to show the selected window at its best size. Since the various chess 
piece sets where draw in different sizes they are best shown in their original size.



Minimizing the current window

As with any windows application you may minimize each client window. Since ChessPartner 
uses Multiple Document Interface (MDI) and some of the windows should not be closed, it 
may be desirable to minimize some of the windows. The currently active window can be 
minimized by the usual windows functions or the appropriate menu selection.



Arranging icons

When some or all of the windows are minimized but are not in view or scattered over the 
screen, you may arrange them in the bottom left corner of ChessPartner’s main window.

Choose the appropriate menu selection from the Windows menu.



Refresh

Redraws the active window. 



Help contents

Displays the contents of the online documentation.



Calling the help index

The main index to the on-line help for ChessPartner can be called from the Help menu. 
Alternatively you may press F1 for the index.

The main index is also presented when topic specific help is not available.



Help on help

In order to learn how the Windows help system function this menu choice calls the Windows 
provided help training.



Using keyboard shortcuts

Some of the ChessPartner functions can be started by a few simple keystrokes without going 
through a set of menus. Below is a list of available key combinations;

Alt+F4 Exit ChessPartner (or Ctrl+X).
F1 Help
F3 Select Engine
Shift+F1 Help for help
Ctrl+D Players definition
Ctrl+N Set the level of play
Ctrl+A Print a game report
Ctrl+Left Go back a single move
Ctrl+Right Go forward a single move
Ctrl+Down Jump into variation.
Ctrl+Up Jump out of variation.
Ctrl+S Start the game
Ctrl+P Stop the chess clock and brain
Ctrl+B Save / replace the current game
Ctrl+L Load a game from the database
Ctrl+C Starts thinking of the computers move
Ctrl+O Move immediately, performing the best move found so far.
Ctrl+K Add an annotation to the current selected move
Ctrl+Z Replace last computer move by the next best move
Ctrl+G Starts a new game.



About ChessPartner for Windows

As with any windows application an about box shows some version information on the 
product you own. So does ChessPartner.

The amount of memory used for Transposition tables can be found here. These values may 
NEVER exceed the amount physical memory present in your computer minus 4 MB. 
Otherwise ChessPartner will need disk space (Windows swap file) for evaluations, making 
the game very slow!



Check when you only want the main variation as result the of the analyses.



Browse file.



Accepts the challenge.



Record the maximum ply depth of the analysis.



Filename where to store the analysis results in.



Check to add the analysis result as annotation to the moves list.



Only analyze the black moves. 



Analyze both the white and black moves. 



Browse for a file to save the analysis results in.



Minimum difference in score to save the analysis results. A value of ‘0’ saves all results.



Only record results if difference in score with previous move is more then the ‘delta score’.



First move to analyze.



Check to save analysis in a file.



File to save analysis results in.



Check to overwrite existing annotations. If not checked the new results are appended to existing 
annotations.



Time to use per move. Format is hh:mm:ss.



Last move to analyze.



Check to use the user book during analysis.



Check to use the endgame databases.



Check to use the current level settings for the analysis.



Use a fixed time per move for the analyzing the game.



Only analyze the white moves.



Show all players names



Record only main variation.



Check to show the thinking during the players turn.



Show annotations in the moves-list.



Type annotation for the current move.



Record the actual time in the analysis results.



Record the score in the analysis results.



Results in statistics window



Show histogram as series of vertical bars.



ChessPartner plays black.



Time increment for each move in seconds.



Select background color for chessboard. 



Show players with a ‘blitz’ rating.



Change color of black fields.



Current color of black fields.



Current background color.



Short description of opening book.



Show bottom 3rd of players list.



Player plays black.



Shows coordinates around the chessboard.



Remote player plays black. Don’t select this, is done automatic during Internet play.



Start time for black in minutes.



The user book has priority over the standard book. 



Sort players list on name.



Sort player’s list on names (no rating).



List of received match requests. 



Edit the selected level, optional change the description.



Check if you want to play black.



Chess server determines the colors.



Check if you want to play white.



Short description of new chess database.



#Analyze the just played game.



Browse for database.



Name of file to export the current selected database to.



List of open databases.



Name of active database.



Check to show only rated players.



Check to move games to export database, else games are copied.



Select search depth. 



Free disc space in KB.



Number of moves to analyze beyond the end of the game.



Name of file to save the analysis results in to.



Only show players open for challenges and available.



Check to show available players (e.g. players not playing a game).



Clear all fields.



Show all game details in the moves-list.



Analyze games from a database.



Select amount of memory to use for the transposition tables.



Just a hint.



Hostname of the chess server. 



Check to ignore the 50-moves rule, mainly useful with the endgame databases. Some endgames have no 
solution within 50 moves.



Input field.



Check to restore the last played game during starting ChessPartner.



List of available levels.



Time for this level, format is: hh:mm:ss.



Search a fixed depth.



Search is for a fixed time per move.



Search is for a average time per move.



Fixed time for the whole game.



A number of moves must be played in a given time.



Search for checkmate.



Time increment after every played move (Fisher clock).



The calculation is infinite (can be used for analyses).



Show histogram as a graph.



Your login name for the chess server. 



For registered users type your password. Leave blank if you are not registered.



Request middle third of players list.



Number of moves in this opening book.



Number of moves to the first time check.



Number of moves to the second time check.



Creates a new level.



Use short notation for moves-list etc.



Use the figurine font for the notation.



Players open for games.



Adjust the animation speed of the chess pieces on the board.



Check to show opening name in moves-list. 



Offer different parameter to the opponent.



Amount of system memory.



Name of player to send challenge to.



Port number to connect to the chess server, default is 5000.



Number of unique positions in opening book.



Prints annotations.



Prints a diagram of the current position.



Print using the figurine font.



Rated game.



Show player’s whit a rating.



Show registered players only.



Reject challenge.



Reject all challenges.



Round of tournament where game was played.



Shows calculations during players move.



The selected level.



Show all players.



Place where game is played.



Show all variations in statistics window.



Show no variations in statistics window.



Show only best variation.



Shows current move in statistics window.



Check to generate sound effects.



Sort list on players rating.



Starts exporting games.



Swap players colors.



Shows players list in a compact format.



Time in hours:minutes:seconds (e.g. 1:30:00)



Time in hours:minutes:seconds (e.g. 1:30:00)



Top third of players list.



Play unrated game.



Show non-registered players.



If checked the computer uses the players time to calculate it’s next move.



Check to use the current games filter for exporting games.



Use hatch brush for the black fields.



Check to make use of the transposition tables.



Check to make use of the user opening book.



Check to make use of the endgame databases.



List of valid moves.



Long format for players list.



List of program modules whit their version information.



Show black on top in histogram window.



Show white on top in histogram window.



Let ChessParter speak to you.



Computer plays white. 



Edit colors of white fields.



Current colors of white fields.



Time increment in seconds.



Shows win/loss statistics.



Player plays white.



White is played by remote player, is automatically selected during Internet play.



Blacks initial time in minutes.



Adds current variation to users opening book.



Select analog clock. 



Only play opening for black.



Blacks move.



Opening can be played for both white and black.



Black’s long castle is allowed.



Black’s short castle is allowed.



White’s long castle is allowed.



White’s short castle is allowed.



Save game’s in compressed format, saves disc space but move times are lost. 



Remove this opening from user opening book.



Adjust blacks clock time.



Name of black player.



Comment for the game.



ELO rating for black player.



ELO rating for white player.



Name of opening as played in game. ChessPartner fills it in if known.



Date of game played.



Name of tournament.



Name of white player.



Format hh:mm:ss.



Relative score for this position. A value of 100 is one pawn.



Adjust whites clock time. (Format hh:mm:ss).



Save used level together whit game.



Save game in standard format.



Save current settings.



Current clock time for black.



Name or part of name of player to search for.



Name of opening to search for.



Search for date or data range. The following options are valid:
· DD/MM/YYYY (Day/Month/Year)

1/1/1993 = Finds games played on 1/1/1993.
· ??/MM/YYYY

??/1/1993 = Finds games played in January 1993.
· ??/??/YYYY OR YYYY

??/??/1993 = Games played in 1993.
· DD/MM/YYYY - DD/MM/YYYY (from – to )

1/1/1993 – 1/3/1993 = Games in date range.
· YYYY - YYYY (from - to)

1993 - 1994 = Returns games played in 1993 and 1994.
The various syntax’s may be mixed e.g:
1922 - 31/6/1928



Filter the database on tournament name.



Name or part of name of player to search for.



Removes only last move of opening variation.



Search only for player playing black.



Player may play white or black.



Only accept a exact match.



Search player playing white.



Name of current user opening book.



Current time on whites clock.



Play only white moves.



Whites move.



Black wins. 



Game is drawn.



Game result in unknown.



White wins. 



Confirm.



Overview of settings for selected level.



Promote to Queen.



Promote to Bishop.



Promote to Knight.



Promote to Rook.



This page contains options specific for the chess engine.



This page contains general options.



This page contains display/view options.



This page contains options to adjust the settings of the chessboard.



Click on caption to activate.



Toolbars.



Check to display moves list in two columns.

1. e2-e4 e7-e5
1. Nc3 Nf6
1. d4
etc.

0 Else:
1 1. e2-e4 e7-e5 2.Nc3 Nf6 3.d4 etc.



Check to print the moves list in two columns.

1. e2-e4 e7-e5
1. Nc3 Nf6
1. d4
etc.

Else:
1. e2-e4 e7-e5 2.Nc3 Nf6 3.d4 etc.



Select voice.



Type of console, “Fics Client” is used to connect to one of the Free Internet Chess servers.
“ChessPartner Client” is selected to directly connect to someone running ChessPartner.
Select “ChessPartner Server” to allow others to connect to this computer.



Check this to let ChessPartner automatically accept the first match request.



Let the computer play the game.



When the game ends it is automatically saved to the current database



Calls the Chess engine specific property pages.



Select a different Chess engine.



Fill in the exact name you have used when you registered the software.



The e-mail address you used when you registered the software.



Type registration ID you received in this field. Make sure you type it exactly as you received it, also match 
upper and lower case letters.



Select the communication port (COM1-COM4)



Check if ChessPartner is the master, the master program is the one that is controlling the match.



Play match with alternating colors.



Total number of games to play.



Maximum number of moves in a game, if this maximum is exceeded the game is declared ended.



If the remote site does not answer within this timeout period the game is ended.



If the score exceeds this value the game is ended and is automatically declared a win/loss.



The name of this program, this is used for saving the game.



The name of the remote program, used for saving the game.



Check to enable the use of the timeseal or timestamp program. These programs are used to compensate 
network ‘lag’. For use of the timestamp or other program you also have to fill in the additional setup 
dialog.



Setup the timeseal parameters specific for this chess server. If you don’t setup the parameters the 
standard global settings are used.



The full pathname of the timeseal or timestamp application. Leave blank to use the standard application.



Fill in the working directory for the timeseal program, leave blank to use the current directory.



Here you can specify parameters that are passed to the timeseal or timestamp program. You can use the 
following special parameters:    %1 is the FICS host name, %2 is the FICS host port, %3 is the local proxy 
port.



Specify the hostname where the timeseal program runs, normally this is the localhost or 127.0.0.1, in 
some occasions you may want to specify a different hostname.



Specify the port where the timeseal program listens on. This is usually the same port as the FICS server.



Here you can fill a command string that must be send after an automatically played game is finished. The 
command string is only send when auto accept and computer plays are active. Normally you would post 
one or more new seek commands. Multiple commands must be separated by ‘\n’. The command string is 
also sent just after login to the server.



If this option is checked, ChessPartner will negotiate extended mode with the remote program. In 
extended mode minor promotions are supported. Some programs don’t understand this, for those disable 
the option.



Check this option if you want the remote program to save the played games.



Edit the color used for highlighting the last move.



Enable the highlighting of the last played move.



Setup the sounds associated with the various events on the chess server. 



Play sound when a new game is started.



Play a sound when the game is ended.



Play a sound when someone challenges you for a game.



Sound when your opponents tells you something.



Sound on kibitzes.



Plays a sound when shout’s are received.



Plays a sound when c-shout’s are received.



No opening book is used.



The user interface handles all aspects of the opening book. The engines books is not used.



The Chess engine is responsible for handling it’s own opening book.



This slider controls how varied the book is, when the slider is whole the way to the left only the best 
moves are played. When whole the way to the right all book moves are played (except those marked as 
don’t play).



Set this slider to the left to ignore what it has learned, to the right to make maximum use of the learned 
information (this may lead to boring play as it never plays a move which ever lead to a lost game).



When checked the program does not look in the next book until there are no more moves in the first book.



List with selected book files, use the buttons to open, close, or change the order of the books.



When checked, a single mouse click moves the game to the clicked position, otherwise a double click is 
needed.



Here you can fill in your name, this information is used to fill in the players name when a new game is 
selected.



Your blitz rating is the rating obtained in blitz games.



Your standard rating.



Select the screen element you want to change.



The color of the selected element.



The font properties.



When checked, the chess board does not have a window border.



Here you can specify a file with commands that are send to the chess server just after you are being 
logged in.



When Random is selected each playable move in the book has an equal probability to get played.



When this is selected, moves with a high score will be played more often.



In this mode, moves that have been played a lot have the highest chance of being selected.



List of pictures you can use as background.



Browse for additional pictures.



Set the background color.



Select how the picture is drawn.





Overview

General
This package is designed for use with Microsoft Windows 95/98/NT. This manual assumes that you are 
familiar with the way Windows operates. If you're not, it is strongly advised to get familiar before installing 
the application. The same applies to playing Chess with this application. Both the manual and the 
program do not provide "tutorials". A basic knowledge of the Chess-game is required; however, a certain 
level of mastering the game is not needed! The program can be adjusted such that its level of play suits 
the player.

About the manual
The manual takes you first through the installation steps. Next, the control and usage of the program is 
described, followed by the use of the built-in Database. After these topics the advanced user gets his turn. 
The manual is not a tutorial, nor does it provide extensive descriptions of all menu-selections. On-line 
help is available when you require detailed descriptions of a menu selection. The manual provides 
guidelines to operate the application    for both novices and experienced users.
The procedures to follow are described step-by-step. It is assumed that you have a sufficient knowledge 
to control Windows. If you don't, study the Windows documentation where necessary.
When a reference is made on using Windows, it is assumed that you use the UK/US-English version of 
Windows
The following notations are used:
· Keystrokes are printed bold and between brackets. For instance, pressing the Enter-key    is printed 

as <Enter>, function keys as <F1>.
· Combined keys are printed as <CTRL-F7> .
· Menu selections are printed in bold e.g. Open file ...

Any additional information and/or changes that could not be printed here can be found in the 
README.TXT file. This file can be browsed with the help of WORDPAD or NOTEPAD. After the 
installation the file can be read by clicking the README.TXT icon. Please read it carefully and make 
notes if needed.



Installation

System requirements
Before starting the installation, please check if your system adheres to the following:
· AT class machine with 486 processor or better.

32 MB RAM. ( 64 MB Recommended )
Hard disk with at least    20 MB free space.
VGA card with 256 color display or better.
Mouse or pointer device.

· The following programs must have been successfully installed:
Window’95, Windows 98, or Windows NT 4.0 or higher

Installation
· The actual installation depends on how you have received the application, if you downloaded it from 

the Internet, just start the self-installing executable and follow the instructions
· Did you get it on a CD-ROM follow the instruction included with the CD-ROM.
· Follow the directions presented by the Setup program. When all questions have been answered, 

setup will copy all the selected files. When finished, setup creates shortcuts under the start menu, 
which contains icons for the various programs.

· The next topics discuss the use and control of the application.



Using the program
This section gives a general overview of how to use the program.

Starting the program
The default installation has placed a shortcut to the program under the Start menu. It depends on the 
specific distribution you have bought where this menu is. The standard Lokasoft version places it under:    
Programs –> ChessPartner 5.0 –> ChessPartner 5.0

When started, a splash screen is shown. The screen closes when the program is fully loaded.

The menus conform to the Windows standard where possible; meaning that functions can be found 
where they usually can be expected; e.g. the first menu is the files-menu containing both file and printer 
choices. The Exit ... dialogue can also be found here.

When a menu choice is not clear, you may press <F1> to get help on the current highlighted menu 
selection. As an alternative you may access the Help through the Help menu.



The Windows
After the application has been started, and the logo screen has been cleared, several Windows are 
displayed, each having its own specific function. All Windows can be moved freely within the main 
Window. Also the size of each Window can be adjusted to your liking. Every time you exit the application, 
both the position and the size of all Windows can be saved so the next time you start the program your 
preferences are still in place!

Clicking the X symbol in the top right corner of a window hides that Window. The window can be restored 
from the Windows menu.

By clicking the right mouse button inside the Window, a pop-up menu is shown with the most common 
functions that apply for that Window. This may save some mouse movement and searching through the 
menus.

The Chessboard Window
This Window shows the current state of the Chessboard and the player’s name. Moves are done by 
positioning the pointer over a Chess piece, holding down the left mouse button and dragging the piece to 
its destination. When the button is released, an attempt is made to play this move. When invalid, an error 
message is displayed and the piece is moved back to it original position. 

To castle, just play the King move, the Rook will be moved automatically. When a Pawn promotes, a 
dialog box appears allowing you to select the piece to promote to. En-passant moves are simply made by 
moving the Pawn.

For faster move entry you may also double click on the destination field, if only one move is possible it is 
carried out immediately; otherwise a small menu pops up.

The Moves List
The moves list contains the list of moves played, optional the moves list can also display the players 
names and other games details. You can navigate the moves list using the toolbar buttons, or the 
navigation functions under the moves menu.

By double clicking on a specific move, the game is moved to that position. The last played move that 
corresponds with the position on the chessboard is underlined.

If you move back in the moves list, then perform a different move on the chessboard, a new variation is 
inserted in the moves list. This is indicated by a series of moves in between round brackets and in a 
different color. A variation can be deleted by double clicking the last move you want to remove, then click 
the red X button from the toolbar.

Moves can be annotated with the Annotate function from the moves menu. To have the annotations 
visible in the moves list make sure the Show annotations option is selected in the general options.

The Clocks Window
This Window contains the Chess clock for both White and Black players. The Clock can be displayed as a 
digital or analogue Clock. In digital display it will do a countdown (00:00:00) during tournament levels. 
Other levels of play will count upward.

The status line also shows the clocks for white and black, always digital.

The Book Window



Here are the moves listed from the opening book(s) that are valid for the current Chess position. If there 
are no applicable moves, the Window is empty. Each move has a number of attributes with it. The score 
is the relative value of the move as seen from the player. The Type field indicates where the move came 
from, a question mark indicates that program will not play the move. 

The remaining 3 fields (White, Black, Total) are only valid when a book with statistic information is used, 
the field contains the number of times the move leaded to win for White/Black. The Total field contains 
number of times this move has been played.

Double clicking a move in the list plays that move on the board. 

The statistics Window
The “thinking” process can be peeked at in this Window. In the View page from the options dialog you 
may define which details are shown here; e.g., main variant, score and search depth.

Histogram Window
This Windows visualizes the value of all positions in the game. You have the option of a Bar graph or Line 
graph display style. Use the view page from the options dialog to set your preference.

Figure 1

The vertical axis represents the score. It automatically adjusts to the maximum score during the game. 
Horizontally the last 50 moves are in view. By double clicking the left mouse button anywhere inside the 
histogram, that move position will be shown on the chessboard. The current position is also shown in the 
move list window. If the moves list contains variations then the histogram only shows the scores from the 
active variation.

Database Window
The database window contains a list of games from an open database.    More than one database can be 
open at the same time, each displayed in its own window. A game can be loaded from a database by 
double clicking on the line with the game. After the game is loaded the database window is minimized.
You can use ‘drag and drop’ to move games from one database to another or drop a game on the 
chessboard window to load it. To start a ‘drag’ operation click on the most left gray column to select one 
or more games, then move the mouse a little bit until the cursor changes shape, now click the left button 
and start dragging. Dropping it on an other database window will move or copy the selected games, 
dropping on chessboard loads the game. Use the <ctrl> key to toggle between copy and move.



Playing a game against the computer

In order to play a game against the program, you must use the player’s definition to set Player / 
Computer. Use the Players ... option from the Game menu to do so. You can choose to play the white or 
black pieces.
When the player makes the first move, the Computer starts calculating a move. During this process the 
caption of the Chessboard Window shows that the computer is at play. In this phase you may check the 
statistics Window for the best variant found so far.
When the computers time is up or the maximum search depth is reached, the best move found so far is 
played, and an optional beep or sound is generated.
During the player’s turn, the Computer thinks about possible countermoves. This is an option that can be 
disabled and, of course, affects the strength of the program.

Let the program play white
If you have set the player definition to have the program play the white pieces and the computer had not 
yet make the first move, use the Start Game function from the Game menu to let the computer play the 
first move. Alternatively you may select Computer move from the Moves menu, this has the effect of 
swapping the players definitions.

Taking moves back
Only during the players turn is it possible to take back moves. When the Computer is thinking you must 
interrupt it by stopping the game or issue an immediate move. The latter can be established by the 
Immediate selection from the Moves menus or pressing <Ctrl-O>. Both cases will set the players turn.
By pressing <Ctrl-T> or <Ctrl-ß> a single move is taken back. With the mouse the corresponding toolbar 
button can be clicked for the same action. When the Computer already has done a move, you must take 
two moves back.

Playing the next best move
During the opening phase of the game, when the program collects move from it’s opening book, you may 
have the choice of playing an alternate move. An appropriate menu choice is available and a keyboard 
shortcut <Ctrl-Z>. It is only available immediately after The program plays it’s move and the move came 
from the opening book or endgame database and there’s at least one alternate move available. As a 
result, the current move will be taken back and the ‘next best’ is played. Next best moves are circular and 
you can rotate through all next best moves.

Let the program generate the players move
During the player’s turn, you can let the Computer do the thinking for you by pressing <Ctrl-C> or select 
Computer Move from the Moves menu. After the move is done, it is the players turn.



Re-playing a Chess game
In order to review a game you select Players... from the Game menu, and set it for Player / Player.
Now the moves can be entered in any available fashion, the Chess brain will validate them however! With 
the navigation buttons you can move backwards and forward through the list.
You may use the Analysis mode option to see what The program thinks of the game. See also the 
analyzing brain option.

Annotating moves in the list
By selecting Annotate... from the Moves menu or by pressing <Ctrl-K> you start a dialogue in which 
some text can be entered (up to 1024 characters). This comment will be connected to the move currently 
selected in the list. This is the move in the list displayed that is underlined. The annotation is automatically 
saved when the game is saved, it is displayed in the moves list.

The analyzing Chess Brain
When you walk through a game, as discussed above, you have the possibility to let the computer analyze 
the moves. By setting the Analyzing brain option from the Chess Engine tab in the options dialog a move 
is calculated for the current position. The results of the analyses can be reviewed in the statistics Window. 
The extend of the analyses is unlimited, meaning that by allowing more time to analyze the better the 
calculated result will be. When a different move is selected, the analysis starts again for that specific 
position.



Setting the level of play
A game of Chess can be played with various degrees of difficulty. The level can be set with the help of a 
dialogue. Select Level... from the Game menu, or press <Ctrl-N> to get the dialogue into view. The 
various levels are organized in folders, each folder containing specific types of levels. It is also possible to 
create you own customized levels.
The following standard categories are available:
· Fixed time for whole game
· For beginners
· Levels with time increment
· Personal levels
· Search depth levels
· Search for checkmate
· Special
· Tournament level
To select a level, just click on one of the folders and select the desired level and click the OK button.
To create a new customized level, first select the folder where you want you new level to appear, then 
click the New Level button. This inserts a new level in the selected folder, now rename the level to your 
liking. Next step is to edit the just created level, click the edit button to start the level wizard.
The wizard guides you through a number of pages allowing the setting of various options.
Some additional functions can be accessed by right clicking on a level. The following chapters give a 
description of the various levels.

Fixed depth
With this level the computer will always calculate a move up to a certain number of ply’s. By selecting the 
appropriate radio button, you may edit the number of ply’s. Values ranging from 1 through 30 are valid. 
Any other value entered will not be accepted by the Chess Brain, and an error message is returned if you 
attempt to set such a depth.
The search depth entered is a so-called brute force depth. On top of this, the computer may do selective 
extended searches in some cases. The higher the search depth you set, the more time will be required to 
calculate the move. Given the exponential nature of the algorithm and the current speed of the hardware, 
a depth of 30 can hardly ever be reached.

Fixed time per move
Unless a Mate, Stalemate, or Draw occurs, the program will play the calculated move when the entered 
time limit has expired. Values of 15 seconds already produce a "do not under estimate me" opponent.

Average time per move
With this level, the computer will use the amount of time to calculate a move as an approximate. At 
certain stages in the game the time entered will be exceeded, but never more than five times the value 
entered.

Time for the whole game
You are given the opportunity to define the total amount of time available for the game. Each player gets 
that amount to finish the game. When a player fails to move before the clock returns to ‘zero’, he looses 
the game.

Tournament levels
A tournament level uses a time limit in which a certain amount of moves MUST be played. It is split in two, 
when the first time limit expires and the required number of moves has been played, the second time limit 



and move count is activated, this is repeated when needed.
Remarks:
· When a digital clock is selected it runs backwards (countdown to 00:00:00). The Analogue Clock ticks 

forward from a preset position.
· Each time the demanded number of moves is reached, the Clock is adjusted to the next time limit.

Search for checkmate
This level is meant to search for Mate positions, and is most likely used on end-games. The value you 
can enter, as a parameter is the search depth ranging from 1 through 30

Levels with a timebonus
This level operates just as the ‘Fischer Clock’ invented by Chess genius Bobby Fischer and accepted by 
the World Chess Union. You define the initial time available at the start of the game and the amount 
added after a move is played. A better spread of time and less change to end up in time trouble is the 
result. Also, you don’t have to adjust the clock as in other tournament plays. Two samples:
basic time: 20:00 min. 5:00 min.
bonus time:  2:30 min. 0:15 min.

---------------- ---------------
total after 60 moves 170:00 min. 20:00 min.

Infinite time
The infinite level is intended for evaluations. The computer will continue to calculate the best move for the 
given position forever until you force a move (<Ctrl O> or stop the game. Note that when there are still 
moves in the opening book these will be played instead of calculating one.



Setting up a position
If you wish to begin a game with a different position than the usual initial Chessboard, it will be necessary 
to put pieces at predetermined places. For that purposes an Edit position... function is available under 
the Edit menu.
Positions (game without moves) can be saved in the database and, of course, be obtained from them too. 
Refer to the topic about using the Database(s).
After you have selected the Edit position mode a toolbar appears at the bottom of the screen, this allows 
you to select the various pieces. The functions on the toolbar are also available from a context menu, 
which can be accessed with a right mouse click.
Pieces can be moved to there required position, to add a new piece click the desired piece from the 
toolbar and drop it on the board. The is a function to move all pieces to their start position and to empty 
the board.
When you are ready click the red V button to complete the setup. This brings up the castle right dialog, 
after confirming this dialog the setup is completed.



Printing
The program gives you the opportunity to print games and diagrams. The following topics show you how 
to accomplish this. All the printing functions can be found with the File menu.
Printing always occurs on the Windows default printer.

Printing the game
To print the current game, use the Print function from the file menu. To control what is printed use the 
General page from the options dialog. You have the choice to print the game including annotations, 
figurines, and diagrams. If the ‘Print diagram’ option is checked the game is printed with the current 
position inserted as diagram.
During the preparation of the print job a small window is displayed, allowing you to cancel printing 
altogether. Other functions are disabled when printing.

Advanced printing
There are situations where the build in printing capabilities are not sufficient, for this reason there are a 
number of copy and paste functions to copy the game to you favorite word processor.
To copy the contents of the moves list window to the clipboard, right click on the moves list and select the 
Copy function. This copies the entire game on the clipboard, including annotations, optional figurine fonts 
etc.
To copy the chessboard window as bitmap to the clipboard, right click on the chessboard and select the 
Copy function. It is also possible to copy the chessboard as a figurine font, in that case select the ‘Copy 
game as font’ function.



Analyzing a game feature
The program can analyze existing games from famous grand masters or yourself.    Its ‘opinion’ can 

be read later on form the annotations in the move list and/or from a text file. The result consists of 
the move number, score and the variant as calculated by Rebel Tiger. From the Extra  menu, 
there are several analysis functions available:

· Analyze Game(s): To analyze the current game, or games from one or more databases.
· Analyze EPD:    To analyze test sets from EPD files.
· Analyze position: Analyzes the current position with the option to either include or exclude 

certain moves. 



The Chess database
The program offers saving and retrieval of games and positions from a database. A database can be used 
as a reference and to keep and recall your interrupted games. It can also be used to collect famous 
Chess games, enabling you to "re-play" or analyze such games.
A database may have various formats. Of course there is a native optimized format but also the Portable 
Game Notation (PGN) formats are supported.
You are not limited to a single database, multiple databases may exist for various purposes. With the New 
database... dialogue, you can create as many as you want, while defining a global description of what the 
new database will contain. White the Open database ....function a existing database can be used. 
Multiple databases can be open at the same time. All functions can be found under the Files menu.



Opening a database
The dialogue presented is similar to opening a file and can be called with Open database... from the File 
menu. The following dialog lets you pick a file: 

Choose the database format (file type) you wish to select from and select one of the possible files listed. 
Upon selection, the Database description is shown together with info about the number of games etc. 
This helps you identifying databases more easily. Press the OK button to open the selected database.    
There may be multiple databases open at the same time. 
Note; when you exit The program, the name of the current open database, if any, is saved. The next time 
you start, that database is opened automatically for you, saving some work.



Creating a new database
You may create a new, empty database containing only a description of what the database is meant for or 
what it will contain.
The file name that you have to provide may contain a drive letter and/or a path, the file extension 
determines the type of database that is created. (native or PGN). If no extension is given the extension for 
the selected database type is used.



Closing the current database
You may close a database by closing the database window, click on the X in the top right corner.



Database maintenance
As a rule, databases require maintenance, and so may these databases. With the Database 
maintenance sub menu some functions are available for repairing and compressing the current 
database. Depending on the selected database format some of these functions may not be available. The 
function always operate on the current selected database, if you have more then one database open, 
make sure the select the proper database.

Information on the current database
Each database has some comment text describing its contents. This text and the amount of 
games/positions saved and deleted can be viewed. The records marked as deleted can be permanently 
removed by compressing the database, with the result that the files take less disk space.

Re-indexing the database
Sometimes it may be necessary to re-index the database. An interrupted compression or abnormal 
program exit (Alt+Ctrl+Del ?) are just examples. In case you experience problems retrieving or saving 
games, you may also wish to re-index the database.
It is possible to interrupt the re-index process but it is definitely not recommended. If you still wish to 
interrupt, use ONLY the button in the progress dialogue.
PS. During the re-index, you can still play games, waiting for completion is not needed!

Compressing the database
Whenever a database has a lot of deleted games, it is recommended that you compress the database. 
This will not only save disk space, but also increases speed searching games. In case you have a game 
open that has not yet been saved, do so before starting compression. After compression you will not be 
able to save the game over the previous version!
Hint: When disk space is scarce, always use the compressed format to save games. Refer to the normal 
format for a list of differences.



Loading a game from the database
Loading a game from the database is easy, just double click on the line containing the game you want to 
view and the game is loaded. The database window is automatically minimized, the moves list window 
contains the moves and the chessboard is moved to the start of the game. You can now navigate through 
the moves in the game, continue playing the game etc. 
When the database contains many games, you may want to search only part of the games. For this 
purpose select the Games filter function. In the games filter dialog you can set various search conditions.

The Date range option holds a number of ways to select games and accepts the following formats:
DD/MM/YYYY (Day / Month / Year)
*All games played on that specific day.
??/MM/YYYY
*All games of a certain Month.
??/??/YYYY or YYYY
*Games from an entire Year.
DD/MM/YYYY - DD/MM/YYYY (from - to)
*Games played in the time span.
YYYY - YYYY (from - to)
*Games played in these years.

Mixing formats is also possible, an example; 1922 - 31/6/1928
Searching by date value through the database does not use a key or index. The files will be searched 
sequentially and in case of large files may take up longer periods of time.
Searching a database on date is usually not a ‘key search’ and depends on the type of database in use. 
In most cases the database needs to be read through sequentially which may take more time for larger 
files.



Saving a game.
You can save game or position, after entering the game details, in a database. Use the Save Game or the 
Save Game As function from the File menu. The first function overwrites a existing game in the 
database. If there is more then one database open, the program asks in which database to save to game. 
In the “Game details” dialog a great deal of information can be entered and attached to a game.

There are two types of fields:
§ Key-fields, these contain text that can be searched with the Filter function. Key fields are:

Opening
User key
White players name
Black players name

§ Information fields, these are all the remaining fields where additional text can be typed. It is 
recommended to always use the comments field, since they can be used to describe a game as YOU 
prefer it.
Games can be saved Normal or Compressed. The normal format saves the time played for each move, 
using eight bytes per move against one byte per move for the compressed format. The compressed 
format uses a different move coding, taking a (very) little bit more time to regenerate a game. Since disk-
space is valuable, use the compressed format where possible.



Drag and drop
A game can be copied or moved. With the left mouse button you can drag and drop a game on various 
places. First select one or more rows containing the games of interest. You can select a row by clicking 
on the most left column. Now move the cursor slightly until it changes shape, now start dragging by a left 
mouse click. Dropping the game on the chessboard or the moves list loads the game.    Dropping on 
another database window moves the selected games. By holding the <Ctrl> key the games are copied 
instead of moved.



Exporting the database
The program offers the possibility to move/copy multiple games from one database to another in a single 
step. First you open the database you wish to export from (read). Next, choose Export from the File 
menu, which presents the following window: 

In the destination field you type the name and location of the file you want to receive the games in. To 
easy locate an existing file, use the … button.
By using the Filter button you may export only a selection of games meeting the filter key values. The 
filter is equal to the one used to list Games as described in a previous chapter.
Depending on the source type of database you may have the option to remove from source. This will 
delete the games you copied to the other database.
Note that not all database formats can be used for export/import.



End game databases
The end-game-databases supported by the Lokasoft standard engine are mainly made by Ken 
Thompson, an American Pioneer in this area who already in 1975 performed revolutionary study and 
tests. In that period he developed endgame databases with 3 and 4 piece endgames. The endgames 
using 5 pieces where developed later on. In other words, endgame databases are around a long time but 
it took a while before (commercial) programs make use of them. This is mainly due to the large size a 
database may take. 100 Megabytes are not unusual for a single database file. Now that CD-ROM are 
accessible to almost everyone, the endgame databases find their way to the public through this medium. 
Considering the size of this multitude of files (currently 4 CD’s full!) a fast CD-ROM player makes sense. 
Quad or six speed drives are recommended although single and double speed will work.

New in this release is the support for the Nalimov endgame table bases.

Definition
An ‘End game’ position “calculated up to mate or draw is about the shortest description we can give but it 
does not cover it in full. simply looking up the best variant for a certain position seems the way to reach 
the end. There are however, many ways (longer) to get to the end. An end game database is therefore 
build differently. Each position has the number of moves that will lead to “conversion”. Conversion means 
where the material or amount of material changes. In other words; when a piece is removed from the 
board or promotion occurs. After conversion a new end game situation exists and requires a different 
database to access.
When you provide the best counter-play against the database the “finale is as far as possible”. When 
played ‘worse’ than opposed the end will be nearer!

5 Piece end game
Such an end game has of course the black and white King plus three other random pieces. Theoretically 
all these positions can be calculated till the games finale. This is a tremendous job and till date only the 
most relevant kind of piece combinations have explored. Its only a matter of time before the others 
appear.
In a number of cases we must ignore the 50-move rule to come to an end. This is not according to 
accepted Chess rules but from a scientific point of view, interesting. The program offers the option to 
ignore the 50-move rule to enable you exploring several end games that require such. Note: Not all 
engines support this function.

Using the end game database
In order to use the (Ken Thompson) databases you’ll need to turn on this feature through the Chess 
brain options. Additionally you will need to define the drive(s) and path(s) where the databases can be 
found using the Advanced.,. engine options.
Note that the program may be delivered with or without End Game CD-ROM’s depending on your 
supplier and price! The Internet distribution does NOT come with the CR-ROM’s
Place the CD-ROM in the CD player. In case you have multiple CD-players you may use multiple end 
game CD’s simultaneously. When you have a CD-ROM Jukebox do NOT use multiple End Game CD’s, 
the swapping of discs takes too long for correct functioning. Further action on your behalf is not required, 
except moving the game to a 5-piece position of course...
From that moment on, when it’s the computers turn, the position is checked to be present in one of the 
databases. If so, you are prompted to put the appropriate CD into the drive if not already present. Next 
the database is queries for the best move. During the search you may be asked to put in another end 
game volume since the position may convert into a different game.
When the position is present in the database, the Statistics window will show it. It will occur that multiple 
best moves exist for a certain position. Using the Next Best feature you can evaluate these paths. The 



Statistics window indicates the presence of next best moves where variant moves are between brackets.
Since the database is constructed to seek for the shortest distance to conversion in the first place and 
mate in the second, it may occur that mate can be reached sooner than the database will show! End 
games where a pawn (7th row e.g.) has an important role are good examples.
 

Nalimov table bases
What has been said about the endgame databases from Ken Thompson, in general also applies to the 
Nalimov table bases. It is recommended to store the table bases on a fast hard disk. The Nalimov table 
bases are also configured in the Advanced.,. engine options page.
Multiple paths may be given separated by semi colon. No matter what path you fill in, the directory where 
the program is installed is always searched first. Standard the program comes whit all the 3 piece endings 
( K+K+piece). Other endgames can be downloaded from the Internet. Check our website for the location.



The Internet functions
The program has the option to play chess through the Internet. There are two methods, one is to make 
use of one of the public chess servers, the other method uses the build in function of The program to play 
to someone else using the same program. Next a tutorial using both methods is given. Both methods 
assume you already have a valid Internet connection and you are not behind a firewall or proxy server. In 
other words you have a transparent Internet connection.

Using a Chess server
On the internet there are many free chess servers active, the function of a chess server is to bring two 
people together in play a game, moves send by one player are passed on to the other player. A chess 
server has many more functions, It can keep track of your ELO rating, allows you to observe other people 
games, you can see who is online, challenge people for a match etc. To make maximum use of a chess 
server you have to register yourself, you will get a nickname and a password. If you are not registered on 
most chess servers you can still play games but they won’t get rated.
To start using a chess server you must take the following steps:
· Create or open an Internet console, the Internet console contains all the settings to communicate with 

a specific chess server. The program contains a number of pre-configured Internet consoles. The 
Internet console has two panes, the top large one contains the responses received from the chess 
server, the bottom small pane allows you to send you own commands.

· Connect to the Chess server using the Connect button from the Internet console. Fill in your name 
and optional password. When connected you should see the welcome screen of the chess server. 
Note: If you have never logged in before, leave the password field blank.

· Now you can use the various commands from the Internet menu. You can find out who is online, 
which games are playing, challenge someone for a game etc.

· Be prepared, someone may challenge you as well, if this happens a popup dialog appears with all the 
challenges received so far. You can accept or decline a challenge. If you accept you can just start 
playing the game. 

· When your finished, use the disconnect button to disconnect from the chess server.

Using a direct connection
It is also possible to play without a chess server, in this case you have a direct connection to someone 
also using the program. One of the players need to take the role as server, while to other takes the role as 
client. Further operation is similar as when using a chess server.
Next a step by step procedure is given for both the server as the client role.

Server role
· Create or open an Internet console, make sure to set the Console type to ChessPartner server. This 

can be done in the console properties.
· To activate the server, press the connect button, fill in your nickname. The console window will show 

<< Server ready on port: 5000 >>
· At this point the server is ready to receive a connection from the remote client. One note, the remote 

client needs to know the computer name or IP address of the server. In case of a dialup connection 
this IP address may be different every time. To find out your current IP address use the dialup 
monitor, this can be found somewhere under details (check your OS manual). In windows 95/98 you 
can also use the winipcfg program, just run it from the ‘Run’ option below the Start button.

Client role
· Create or open an Internet console, make sure to set the Console type to ChessPartner client. This 

can be done in the console properties. In hostname file in the computer name or IP address of the 



remote player.
· Press the connect button to active the connection. Fill in your own name. If all goes well, you should 

see the welcome screen from the remote server, like : << Chess partner welcomes
you>>.

· Now there is a direct connection between the two programs, you can chat by just typing some text in 
the console windows and pressing enter.

· To start a game use the Challenge command just as you would do when you are connected to a real 
chess server. If the remote player accepts the challenge the game is started.

Using ICQ
It is possible to find out the remote player’s IP address when both players have an ICQ account, for 
instructions how to do this check out the ICQ documentation.
Also it is possible to start the program with some command line options to pass the IP address. 

Command line parameters:

CP5.EXE    Filename [options]
Filename should be the name of a saved Internet console configuration, e.g. “icqfriend.fic” . If the 
filename contains spaces, you must enclose it in quotes.

The following options can be used:

/Host=name[:port]

With this option you can specify to which remote computer to connect. The name can be a hostname or a 
IP address plus an optional port number.

/HostType=n

This option specifies to type of host to connect to, the n parameter can have to following values:
0 - Internet Chess Server
1 - ChessPartner Client
2 - ChessPartner Server

/Name=username[:password]
Here you can pass the user name that is sent during the logon sequence.

/HostOptions=n
Additional options can be given, the value n are a number of bit flags. 1=computer plays, 2=auto 
challenge accept.

Sample ICQ configuration:

External Application Executable:
c:\Program files\Lokasoft\ChessPartner5.0\CP5.exe
Command Line:
/Host=%i:5000 /HostType=1 /Name=%h

External Application Server Executable:
c:\Program files\Lokasoft\ChessPartner5.0\CP5.exe
Server Command Line:
/Host=localhost:5000 /HostType=2 /Name=%h



Chess server commands
This section gives an overview of the various Chess server commands. Not all of the commands are 
always available, this depends on the context, whether you are connected to a chess server or to a 
remote ChessPartner.
To send a command, just type it in the console window and <Enter> to send.
For the most common commands there are easy to use menus available. For the less used commands 
you may have to fall back to typing the command in the console window.
To find out what commands a specific chess server understands, type the help command. For help on a 
specific command the syntax is usually: help    xxx Where xxx is the command you want help on.
Some of the commands can be accessed by right clicking the mouse on the Internet console, the menu 
depend on the context where you have clicked. If you clicked on a name in the list one of the context 
menus would be: Challenge player

Games
The games command returns a list of games in progress, there is a dialog available from the Internet 
menu, this allow you to set various options.

Observe
With the observe command you can observe the moves of a game in progress. After observe type the 
name of one of the players of the game you want to observe. The list of games can be retrieved with the 
games command as discussed before.
The moves list with be filled with moves from the point you start observing, thus earlier moves are not 
listed.
Use the unobserve command to stop observing the game.
There is an easier way to observe a game, first ask for a list of games, then right click on one of the 
player names in the list, the drop down menu has the observer command.
If you don’t want others to observe the games you are playing you can use de command: set private 1. To 
cancel this: set private 0.

Who
The who commands gives you a list of logged in players, if there are more player than fit on one screen, 
use the next command to get the next screen.
The who command as many options, we won’t describe them here. The program has a dialog, which 
allows you to use the most common options of the who command. The dialog can be found under the 
Internet menu.

Sending and receiving game requests
To challenge someone for a game use the following procedure: 
· First check who is available for games using the who command.
· Right click the mouse on the player you want to challenge, from the drop down menu select the 

Challenge command. This sends a challenge with default parameters. If you hold down the <Shift> 
key while mouse clicking you will get a dialog which allow you to fill in some parameters.

· If the remote player accepts the challenge you can start to play.
Other may challenge you as well, when this happens a dialog pops up with the challenges, you can either 
accept or decline the challenge. It is also possible to do a counter challenge with different parameters.

Playing the game
When you have accepted a challenge or some accepted you match request, the game can begin. Moves 
can be played as usual, just move the pieces on the board. Moves from your opponent are automatically 
played on the board.
During the game there are a number of commands available.



Resign

The opponent wins the game; no answer from opponent is required.

Draw

Send a draw offer to the remote player, the opponent can accept or decline the offer. When there is a 
legal draw, e.g. 50 moves rule or 3-fold repetition the chess server automatically accepts the draw offer.

Adjourn

Adjourns the game. The server saves the game. You can continue the game at a later time.

Flag

The opponent has lost on time, this command must be send to claim a win. The chess server verifies the 
claim.

Chat

You can chat with others on the chess server. With the ‘say’ command you can send a message to your 
current opponent. If you are not playing a game you can use the ‘tell’ command. E.g.

Say Great match, huh ?
Tell knight what is your personal rating ?

When you receive a message is looks like this:

<player> tells you <message>
e.g.
Knight tells you My rating is 2234

When you are a registered player and don’t want messages from non registered players you can use the 
‘set tell 0’ command. ‘set tell 1’ accepts messages again.

Stopping
To stop the session with the chess server you can either type the quit command from the console window 
or click the disconnect button from the toolbar.

Letting the program play on the servers
Instead of play the moves your self; it is also possible to let the computer play the moves. Normally this 
should only be done if you are logged in using a computer account, generally it is considered cheating 
when you let the computer play using a normal account.
In order to let the computer play you have to check the ‘Computer Plays’ option in the Internet console 
properties. You can only change this setting when you are not connected to the server. If you want to play 
fully automatic you can also check the ‘Automatic Challenge Accept’ option.
The contents of the ‘Auto Seek Command’ field is send at the end of each completed game, normally you 
would use this to place new seeks. Multiple commands can be issued by separating them by \n



Advanced options
This section gives a description of the more advanced options.

Editing advanced options
Within the program many parameters can be changed. Many off these options can set with options 
dialog box, which can be found under the Extra menu.

Saving current settings
Each time you start the program, the application and its Windows appear at a certain location, a specific 
level-of-play, and with player’s names, etc. These values can be changed during a game session with the 
various menus and dialogues. To prevent you from entering those preferences over and over again, you 
may save them as standard settings. Use the Save setting function from the extra menu.



Chess engine options
On this page you can set the various options for the chess engine.

Permanent brain
This option defines whether or not the brain uses the time when the opponent is thinking to calculate 
moves. In other words the computer looks up a best move for the opponent and a countermove.

Transposition tables
The program can make use of so called transposition tables that will speed up calculations considerably 
for end games. It will also allow bigger search depths to be reached. It is recommended that you leave 
this setting on for all levels, unless you feel the program is much too strong for you...

Use endgame databases
To let the program make use of the end game databases you must check this marker. In case you don’t 
own any end game CD do not turn it on. And, in case you rather have the chess engine calculate the 
moves in the final stages of the game, you can also leave it off. In case you do want to make use of the 
end game databases read the topic in this manual first.

Ignore 50 move rule
Usually the chess engine uses and applies the 50-move rule. As discussed in the end game database 
topic, are circumstances possible where this rule is not wanted. Specific end -game databases require 
ignoring the rule or the game’s end is not in reach. To view such situations this option is present.

Advanced
The advanced button calls up a dialog, which is provided by the chess engine, as it is possible to use 
different chess engines the actual functions of this dialog, varies between different chess engines.

Engine
This option allows you to choose a different chess engine, after clicking the button a list of available 
engines is displayed.



The WinBoard adapter
The program comes with a winboard adapter that allows the use of winboard compatible Chess engines. 
The following pages give more information about the use and configuration of the winboard adapter.

To use the adapter Select Extra -> Options on the Chess engine tab click the Engine button, there should 
be an entry "Winboard adapter" in the dropdown list. This selects the plug-in module. You may get an 
error message asking to edit the engine profile, responding yes brings up the plug-in profile selection 
dialog. Select crafy or gnuchess, you must edit the profile for the location of crafty or gnuchess.
In this release the profile is stored in a simple text file, each engine profile start with a line [name] where 
name is CRAFTY, GNUCHESS, etc. The file is located in the windows directory and called:

ENGINEEXT.INI

Make sure to save the settings!

Of course you first have to install the various winboard engines. It is recommended to install each engine 
in its own directory below the engines directory in the installation directory e.g.

C:\Program Files\Lokasoft\ChessPartner\Engines\Crafty
C:\Program Files\Lokasoft\ChessPartner\Engines\GNUCHESS
etc.

The ENGINEEXT.INI file contains a number of sections.
There is one section for each engine. A section starts with the engine name in between square brackets 
e.g.
[Crafty]

Below this line there are a number of parameters that can be set, the most important are the first four:

Console=?

If console is set to 1 all commands that are send to the engine are displayed in a console window. Set this 
to 0 to hide the console window.

Logfile="engineext.log"

If a filename is given all commands are also saved in this file, useful for debugging. If left blank no logging 
is done.

EngineDir=""

EngineDir specifies the directory where the engine is to be runned from. If left blank the directory of the 
chess engine is used.

EnginePath="eninges\crafty\wcrafty.exe"

EnginePath is the command line used to start the engine, is may be an absolute or    relative path. In case 
of a relative path the installation directory is used as base.

Furthermore there are some parameters to control what kind of commands are send to the engines. In 
most cases it is not necessary to change any of these. A command string can contain \n which is the 
same as enter typed from the command line. In this way it is possible to send multiple commands to the 



engine.

Options=n

The Options keyword controls various aspects of the adapter. The following options are defined: 
1 – Invert score
2 – Send time/otime before engine is instructed to compute a move.

Options=2 - Sends time/otime
Options=3 - Same + score invert.

EditMode=?

Editmode 0= use editstring, followed by the pieces e.g. GNUCHESS,
1=use setboard + fen e.g crafy mode

InputMoveDelay=30

This specifies the time in milliseconds to wait after a move has been received from engine but before 
passing it on to the GUI, is intended to receive possible end of game conditions like checkmate, resign 
etc.
Default is 30

OutputMoveDelay=0

This is the minimum time to wait, before sending another move.    Default is 0

ExitString="quit\n"

This string is send to exit the engine.

EditEndString=".\n"

String sent to end the edit board mode.

SwapColorString="c\n"

This string is send in edit board mode to swap the colors.

EditString="edit\n#\n"

This string is send to start the edit board mode. Is only used when the edit mode is 0.

ForceString="force\n"

The command is send to the engine to set the engine to play neither color ("force mode").    Stop clocks. 
The engine should check that moves received in force mode are legal and made in the proper turn, but 
should not think, ponder, or make moves of its own.

UndoMoveString="undo\n"

If you have Rebel Tiger take bake moves, it sends this string for each move to takeback. Before sending 
this string it firsts sends the ForceString.



ColorStringw="white\n"

Command send to have the engine play the white moves

ColorStringb="black\n"

Command send to have the engine play the black moves.

ComputeString="go\n"

Command send to start the engine thinking it's best move.

MoveNowString="?\n"

This command is send to the engine to force it to play a move right now.

NewGameString="new\nrandom\nponder on\n"

This string is send when a new game is started. You may want to modify this string to set some additional 
options. You make sure the engine is ready to start a new game.

InitString="xboard\nnew\nbeep\nhard\npost\nponder on\n"

This string is send when the engine is first loaded. You may want to add some additional options; 
important is that the engine is working in a winboard compatible mode.

NameRev="Crafty v15.14"

This string is displayed in the engine properties page and also show when you play the engine on the 
Internet. Fill the name and version of the engine.

PonderOn="hard\n"

This string is send to enable pondering, if this string is specified you must also have a PonderOff key.

PonderOff="easy\n"

This string is send to disable pondering, if this string is specified you must also have a PonderOn key.

SetAnalyseMode="analyze\n"

This string is send to set the engine in analyze mode, if this string is specified you must also have a 
ExitAnalyseMode key. If the engine does not support the analyze mode leave these keys blank.

ExitAnalyseMode="exit\n"

This string is send to leave the analyze mode, if this string is specified you must also have a 
SetAnalyseMode key.

Then there are a number of level strings, these are used to map the Rebel Tiger levels to the level 
commands understand by the engine.

Rebel Tiger has 7 kinds of levels, each kind of level has some parameters with it. For each kind of level 
you can define a string with parameter replacement that is send to the engine.



The following parameters can be inserted:

%1 = First search depth in ply's
%2 = Second search depth in ply's
%3 = First time check in seconds
%4 = Number of moves until first time check
%5 = Second time check or time increment in seconds
%6 = Number of moves for 2nd time check
%7 = First time check in minutes (Same as %3 but then converted to minutes)
%8 = First time check remainder seconds (Use in combination with %7)
%9 = Second time check in minutes (Same as %5 but then converted to minutes)
%10 = Second time check remainder seconds (Use in combination with %9)

Level0=level 1 9999 0\nsd %1\n

The Level0 string is send when a fixed search depth level is selected. The %1 parameter is the requested 
search depth in plies.

Level1=sd 29\nlevel %4 %7 0\n

This string is send when a tournament level is selected. The %3 and %4 parameters are for the first time 
check, the %5 and %6 for the second time check.

Level2=sd 29\nst %3\n

String is send when a fixed time per move is selected; the %3 or %7 and %8 parameters contain the 
selected time.

Level3=level 1 9999 0\nsd %1\n

This string is send when a search for checkmate level is selected. The %1 parameter is the selected 
depth.

Level4=sd 29\nlevel 1 %7 %3\n

This is send when a level with a average time per move is selected. The %3 or %7 and %8 parameters 
contain the selected time.

Level5=sd 29\nlevel 0 %7 %5\n

Level with a time increment after each move is made ("fisher clock") The %3 or %7 is the base time, the 
%5 parameter the time increment.

Level6=level 1 9999 0\nsd 29\n

This string is send if the infinite time level is selected.

Known problems.

For a number of features Rebel Tiger relies on functions in the chess engine, e.g. the opening book 
display and some others. These functions are not present in other chess engines so these functions are 
disabled.

Testing has mainly been done using crafty.



On occasions the chess engine does not exit.

Not all levels are interpreted correctly.

DISCLAIMER
THE WINBOARD ADAPTER IS UNSUPPORTED SOFTWARE. WE HAVE INCLUDED IT IN THE HOPE 
SOMEONE FINDS IT USEFULL. AS IT’S OPERATION RELIES ON SOFTWARE
OUTSITE OUR CONTROL WE CANNOT MAKE ANY WARRANTY OF ITS PROPER FUNCTIONING. 



General options
General options are those that influence the programs behavior at one or multiple places. The option can 
be set in the General page of the options dialog. 

Sound
The computer can produce several sounds to get the players attention for various situations; e.g.; Players 
turn, Chess-messages, faults, etc.
Sounds can be simple "beeps" that catch the attention but do not irritate, or even specials like speech! If 
you do not want any sounds, turn off the check-box.

Speech
The program offers some messages as WAVE playback. It is only available if you use a device (and 
driver) that supports WAVE files such as a SoundBlaster or compatible card.
Special sounds can be activated by setting the check-box. The setting of Sound effects must already be 
on. Several voices are available, these can be selected with the drop-down box.

Autosave last game
Enabling this option provides you with the last position and complete move list of the game played upon 
exiting the program. This prevents you performing save-and-load steps between sessions.

Short notation
When checked the short notation is used for displaying the moves.

Figurines
Instead of the usual letter symbol, a picture is used in displaying the moves.

Columns
The moves list can be either displayed as a stream of text, or it can be displayed in two vertical columns.

Showing annotations
When this option is checked the annotations are displayed together with the moves in the moves list. 

Show opening name
The name of the opening is shown.

Show all game details
All the game details are shown at the top of the moves list. This includes things like; player names, 
tournament, round, etc.

Print annotations
The annotations are printed.

Print diagrams
A diagram of the current position is printed with the moves list.



Print with figurines
The figurine font is used in the printed moves list.

Print in columns
The moves of the game are printed in two vertical columns.



View options
In this page the various options affecting the display can be found.

Statistics options
There are a number of options that control the display of the statistics window.

Current move

The move currently being analyzed is displayed.

Show thinking during players turn

The activity of the permanent brain is shown.

None

No variations are shown

Best only

Only the best variation found so far is displayed.

All

All best variations found are displayed in a scrolling list.

Histogram options
Here you can control the display of the histogram.
You can choose between a bar and line graph style of display. Also the point of view (White or Black’s) 
can be selected. It visualizes the path the score follows and if it looks good for White or Black. 



Chessboard options
The chessboard options can be found in the Chessboard page, here the options that affect the display of 
the chessboard can be found.

Field colors
Use the buttons to adjust the colors of the white and black fields. This option only works when selected 
piece set does not make use of a bitmap picture of a chessboard. You can use the hatch option to have 
the black fields hatched.

Sliding pieces
When the program is moving the pieces on the chessboard you have the option to change the speed at 
which it happens. The slide bar allows you to increase or decrease speed and is also related to the speed 
of your machine. The ‘fastest’ possible setting performs no animation at all, piece are move from - to at 
once.

Show board coordinates 
Many Chess players know the board by heart. For beginning players it may be handy to locate the fields 
of the Board with the help of an index border. Horizontally the letters 'a' through 'h' are displayed and 
vertically numbers '1' through '8'. Especially when the Board is rotated locating fields is not so easy. 
Check the box with the appropriate name.



Adjusting the Chess Clock
Using the Clocks... dialogue from the Games menu, the current time settings can be changed.
 During a Computer-Chess tournament, some time gets lost due to the fact that the operator must perform 
the moves as well as other handling. To compensate for this lost time, it is necessary and allowed to 
adjust the Clocks. Also, in some situations, the tournament organization has the right to set Clocks. 
Usually the values provided by a mechanical Chess-Clock may be copied into the electronic Clock.
The dialogue continuously shows the updated Clocks in the right-hand-side boxes when the game is not 
paused. New values can be entered in other edit-fields.
In tournament levels, the time displayed is the time left to play. In other cases it reflects the time played so 
far!



Selecting a different piece set
The program comes with a choice of piece sets peek or select them with the Select piece set dialogue 
below the View menu. The dialogue shows some of the pieces in the set in a list box. 
Because the piece sets have been created in different sizes, they look at their best in their original size. 
Select the Optimum Size from the Windows menu to re-size the Chessboard such that the piece set 
looks at its best!



Choosing a graphical Clock
As mentioned before the Chess clock can be displayed as a digital or analogue clock. The analogue clock 
is a graphic implementation of the mechanical clock, where you may choose from some pre-defined 
graphs. 
Selecting a clock is similar to selecting a piece set, but the size of the clock window is automatically 
adjusted. Re-sizing the clock window may distort the image and can be restored using Optimum Size 
from the Windows menu.



The opening books
The program allows you to maintain your own set(s) of openings next to, or in place of the main book 
supplied with the program. Multiple user books may exist and can be active at the same time. Switching 
between user books can done at any time during the game.
Various functions related to the user book can be found below the Book maintenance sub menu located 
under the File menu. It is also possible to let the selected Chess engine handle it’s own book, in that 
case some of the functions described below are not active.
Some additional options are available from the book moves window by selecting the books tab.
The next topics describe each book function.

Open a book
To make use of an existing user book, it needs to be opened. Use the Open book menu choice to do so. 
With the help of a (common) dialogue, a file can be selected and a short description of the book is shown. 
By pressing OK the book is loaded and can be used by the program. 
There can be a maximum of four books open at any one time.
NOTE: User books have the .BK extension.

Creating a new user book
By choosing New Book a dialogue allows you to enter a filename. A second dialogue allows you to enter 
a description of the book and the type of book. The filename must have the .BK extension and will be 
automatically selected as the active user book.

Closing a book
To close a book, select the books tab from the books window, and then select the book you want to close 
and click the X button.

Changing the book priority
The opening books are consulted in the order they are listed in the books window, to change the order, 
first select to book you want to change, and then use the arrow buttons to move the book either up or 
down.

Book properties page
The book property page contains how the opening books are used:

The book handling options determine how the book is handled, choices are:
· None checked - No book is used.
· Use GUI books - The GUI is responsible for handling the opening books.
· Use Engine books - The current selected chess engine is responsible for handling the opening 

books.
If both GUI and Engine books are checked, the GUI books are always consulted first. Only when 
there are no more moves in the GUI books, the engine books are used.

The Move distribution option control the way book moves are selected:
· Random - Move selection is strictly random
· By learned scores - Moves whit a high learned score will be played more often then moves with a 

low score.
· By times played – Moves that are played more often have a higher chance of being played.



When Priority Select is checked only moves from the highest priority book are played, only when the 
highest priority book has no more moves, the next book is consulted.

The Variation slider controls how varied the selection is, moving it all to the left means only the best 
moves are played, which can get a bit boring. When moved to the right it can also play moves, which may 
be less optimal. The middle is the recommended setting.

The Learning slider controls how much use of the learned information is made, to left means no use of 
learned information is made, to the right a single lost game can be enough to avoid playing the variation 
again.

Adding opening variants
Variants, or even complete games, can be added to the book. Proceed as follows:
· Play the variant up to and including the position that has to be added to the user book. It is not 

required that the variant starts from the initial (new game) position!
Select Add variation from the Files - Book maintenance menu.

· The dialogue now shows the variant, you may decide whether White, Black or both can play the 
variant. You may also set a score for the variant with a value between -127 and +127 as opposed for 
White. 

· Select the proper book from the drop down list.
· Now press the Add button to add the variant to the current user book.

Deleting opening variants
The procedure to remove variants from the user book is similar to adding them:

· Play the variant up to the position that has to be removed.
· Select Delete variation from the Files - Book maintenance menu.
· The dialogue shows the variant.
· Select the proper book from the drop down list.
· Press the Ok to remove the variant from the selected book.
· If the variant overlaps another variant, only the non-overlapping part is removed. This will prevent the 

other variant from being damaged!

Updating book moves
It is also possible to directly edit various properties of the individual book moves. To do this, right click on 
the moves in the book moves window, and select the Update moves menu function.
A dialog with a list of moves will be shown, each move can have a number of attributes, the score can be 
a number between –127 and +128. The priority attribute determines if the move is playable.    0=don’t 
play, 5=best move, 3=normal move.
Not all books support all priority.



Customizing the menus and toolbars
It is possible to customize the toolbars and the menus. The customize functions can be accessed from 
the Customize function under the Extra menu.
The property page contains several tabs to customize the menus and tool bars. Most of the functions are 
accessible using drag and drop. Once in customize mode, buttons and menus can simply be dragged and 
dropped to your liking. 
Once the setup is to your liking it can be saved as part of a layout.



The Clipboard
The program allows some uses of the Windows clipboard. These functions can be found below the Edit 
menu. The current moves list, or graphical Chessboard can be copied to the Clipboard. The move list can 
be copied with or without the annotation texts. The Clipboard's contents can then be used by a text editor 
to produce reports, etc., in addition of the build in print functions.
The usage of the Clipboard in reverse order is available too!
By putting a move list in ASCII format onto the Clipboard, with NOTEPAD for example, it can be imported 
move-by-move. Choose the Paste selection It will only be available for selection if an ASCII text format is 
available on the Clipboard. The notation offered can be either short or long, where the latest has 
preference since short notation may cause ambiguity. Only moves may be listed, optionally preceded by 
move number. Annotations, etc. are not supported! Copy a move list to the Clipboard and study the 
format from the Clipboard by pasting it into a NOTEPAD as a simple Clipboard format. 
It is also possible to have a game in full PGN format on the clipboard, this is automatically handled.



Macros
The macros feature was originally developed to measure the strength of the program in an automated 
fashion. A script can be used to evaluate a great number of positions without the need for human 
intervention. The macro functions can be found in the Extra menu.
A script is basically an ASCII file consisting of VB (Visual basic) commands.    Currently the documentation 
for the macro functions is not yet available.



Context menus
To make popular features quickly available they are connected to the related Window. It’s accessible by 
clicking the right mouse button while the pointer is in the window area. The menu will pop-up nearby the 
pointers vicinity.



Support programs



Book conversion program
Opening book conversion application

This application is intended to convert native or PGN databases to the opening book format.
It is possible to convert multiple databases into a single book file.
The maximum number of moves from each game to add can be set. Selecting a high (e.g. 999) number 
will add the whole games to the book.
If desired only the white or black moves can be added.

Warning! Depending on the number of games to convert, the conversion can take quite some time. The 
average conversion speed is a few games per second, thus conversion of 100000 game may take as 
much as 13 hours or more.

Also make sure there is enough free disk space available, a book file takes much more space then a 
database. Average 10-20 bytes per position is used, so to create a book from the first 15 moves of 
100000 game would take: 100000 x 15 x 2 x 10 = 30000000 = 30 Megabyte    !



Database conversion program
The installation contains an application to convert and merge databases, this program runs from a DOS 
command line, to operate:

Start the program from a DOS prompt:
Usage:

BATCHCVT [options] indatabase outdatabase
Options:    /s - traverse sub directories
indatabase - input database(s) wildcards allowed
outdatabase - output database, must exist

e.g. BATCHCVT /s *.PGN BIG.LDB
This command converst all PGN databases into one big native database

Note: If you just want to convert a single database, use the Export function from the File menu.



Register

To continue using ChessPartner after the 30 day evaluation period you have to register it. 
Registration can be done online using your credit card, for details see the register.txt file or 
check our web site (http://www.lokasoft.nl/uk) for the latest information and prices. 

You can also buy ChessPartner at:

http://www.soft-shop.com

In general the registration process has the following steps:

· Register online using your credit card or any of the other payment methods
· You will receive a registration ID usually by e-mail
· Select Register from the Help menu
· Enter your name, e-mail address, and your ID here, that’s it

When you're registered you will not be annoyed by the initial "splash" dialog. It also entitles 
you to free minor product upgrades until the next major release.

Make sure to store your registration ID in a safe place, you need it if you need to re-install the 
software.





Lists the default menus with toolbar buttons, commands, and menus that you can add to a toolbar or menu. When you select an 

item in the list, toolbar buttons, commands, or menus appear in the box on the right and can be dragged onto a toolbar or menu.



Displays a list of commands from the category you select in the Categories box. To add a command to a toolbar, drag the item 

you want from the Commands box onto a toolbar.



When available, provides a description of the item selected in the Commands box.





Lists the available toolbars. To display a toolbar, select the check box next to the name. To hide a toolbar, clear the check box.



Specifies that button text for the selected toolbar will be displayed.



Removes any changes you made to the selected toolbar and restores the original settings.



Resets all default toolbars to the original settings.



Click to create a new, empty toolbar that you can add buttons and menus to.



Click to change the name of the selected custom toolbar.



Removes the selected custom toolbar.





Lists the available menus.



Lists the available context menus.



Resets the selected context menu to its original settings.



Resets the selected menu to its original settings.



Changes the way menus display when you click on a command. For example, Slide Menu Animation causes the menus to 

display with a sliding motion.



Displays menus with shadows.





IDC_BCGBARRES_LIST_VIEWS



IDC_BCGBARRES_NO_DBLCLIICK



IDC_BCGBARRES_USE_DBLCLIICK



IDC_BCGBARRES_LIST_OF_COMMANDS





Click the command for which you want to assign or remove a shortcut key assignment. If you don't see the item you want, click a 

different item in the Category or Commands box.



Displays all available document templates.



Displays the current shortcut key assignments, if any, for the currently selected command. 



Press the keys you want to assign to the selected command.



Assigns the currently selected command to the keyboard shortcut that appears in the Assign new shortcut box.



Removes the shortcut key combination that is selected in the Current shortcuts box.



Restores all the shortcut key combinations to their default setting.





Displays on-screen descriptions of toolbar buttons when the pointer pauses on them.



When selected, displays the shortcut key in the ToolTip for a toolbar button (if one is available).



Increases the size of toolbar buttons so that they are easier to see.



Activates Look 2000.



Shows basic and frequently used commands on personalized versions of menus. Clear this check box if you want to show all the 

commands on the menus. 



When you rest the pointer over an open menu, shows all the commands on the menu after a brief delay.



Clears menu and toolbar settings which automatically saved when you choose menu commands and toolbar buttons






